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Using the Common Ground Search Facility

Unlike the ProViewer's Find and Find Again commands, which look in the current document 
only, the Common Ground Search facility allows you to look through collections of 
documents to locate those documents that contain specific text phrases.

A collection is a defined group of documents that have been indexed for rapid search and 
retrieval. Collections are created by the publisher of the CD-ROM and included on the CD, 
along with the associated Common Ground documents. You can search in one or more 
collections to locate documents that satisfy your query. The Common Ground CD Search 
application can only work with collections already included on the CD, it cannot create new 
collections.

The ProViewer's Search menu contains the different Search commands, many of which are 
also present as icons on the ProViewer's Toolbar. In addition, there will usually be an icon in 
the CD's program group which gives you direct access to Search without having to launch 
the ProViewer. The Search Results List displays any matching documents as a result of the 
search. You can use this list to select and view the documents in the ProViewer.
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Selecting a Collection

You can choose which collections you want included in the search process. You check (or 
uncheck) collections in the Document Collections dialog box to identify which collections to 
include in the search. Collections that have a check mark in the check column will be 
included in the search; collections without a check mark are not included in the search.

To select a collection:

1. Open the Document Collections dialog box using one of the following methods:

· Double-click the Search application icon in the Program Manager/Explorer. 

· Select Query... from the Search menu in the ProViewer, then click the 
Collections... button. 

2. Double-click in the check column next to the document you want to select. 

You can also click the collection description and press the space bar once to 
select a collection.

To deselect a collection:

1. Open the Document Collections dialog box using one of the following methods:

· Double-click the Search application icon in the Program Manager/Explorer. 

· Select Query... from the Search menu in the ProViewer, then click the 
Collections... button. 

2. Double-click the check mark next to the document you want to remove from the 
search. 

You can also click the collection description and press the space bar once to 
deselect a collection.
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Starting a Search

You can search through documents in one or more collections using the Search window.

To start a search:

1. Open the Common Ground Search window using one of the following methods:

· Click the Query icon in the Toolbar

· Choose the Query command form the Search menu

· In the Program Manager/Explorer, double-click the Search icon in the Common 
Ground Program Group

2. Choose "All collections" (the default) or "Selected collections" from the Search in 
menu.

· If you choose "All collections," be aware that the search could take a long time, 
return too many documents, or return documents that you do not need.

· If you choose "Selected collections," Search will only look in check-marked 
collections in the Document Collection list.

3. Type your search string into the Search for field.

Click here for more information on search string syntax.
4. Click the Search button. Search locates all documents that satisfy the query and its 
constraints.
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Specifying a Query

You enter your query in the Search for field of the Search window. The simplest form of 
search requires only that you have one collection selected and type a search string, or 
search term, into the Search for field. You can perform a more complex search, using options
or constraints not available to you in the query language, by expanding the Search Window.

The following examples show how to specify different search terms. 

Simple Search Term

A simple search term is either a single word, a single word preceded by not, or a phrase. 

Example Explanation

A Look for documents that contain A.

A B Look for documents that contain A immediately 
followed by B.

not C Look for documents that do not contain C, or, 
equivalently, exclude documents that contain C.

Compound Search Term

A compound search term is two or more simple search terms connected by operators and 
and or. 

The and operator takes precedence over the or operator. Also, when present, the not 
operator is always applied first.
Example Explanation

A and B Look for documents in which both A and B appear.

A and B or C Look for documents that contain A and B, or 
documents that contain C.

A and not B Look for documents that contain A and in which B 
does not appear.

Building Search Terms

1. You can use parentheses to clarify combinations of search terms.

Example Explanation

A and (B or 
C)

Look for documents that contain A and documents that 
contain either B or C.

2. You can search for a phrase containing a reserved word by enclosing that word in 
quote marks. 



Example Explanation

A "and" B C Look for documents that contain A followed by "and" followed
by B C.

3. You can enter a list of search terms separated by commas. The search retrieves 
documents that include at least one of the search terms you specify. 
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Navigating the Results of a Search

When the ProViewer displays the document that you selected from your Search Results List, 
the first or selected search hit is displayed near the center of the Document Window. 
Commands on the ProViewer Search menu allow you to look forward and backward in the 
current document for search hits and to move forward and backward in the Search Results 
List to view other documents retrieved by the search.

To navigate via search hits within a document:

· To display the portion of the current document that contains the next search hit, click 
the Next Hit icon on the Toolbar or select the Next Hit command from the Search 
menu. This command and its icon are inactive when there are no additional hits in 
the current document.

· To display the portion of the current document that contains the previous search hit, 
click the Previous Hit icon on the Toolbar or choose the Previous Hit command from 
the Search menu. This command and its icon are inactive when there are no previous
hits in the current document.

To navigate via search hits across documents:

· To open the next document in the Search Results List -- click the Next Document icon 
on the Toolbar or choose the Next Document command from the Search menu. Next 
Document automatically closes the current document before opening the next 
document in the list. 

This command and its icon are inactive when the current document is the last 
document in the Search Results List.

· To open the previous document in the Search Results List -- click the Previous 
Document icon on the Toolbar or choose the Previous Document command from the 
Search menu. Previous Document automatically closes the current document before 
opening the Previous document in the list. 

This command and its icon are inactive when the current document is the first 
document in the Search Results List.

To redisplay the Search Results window:

· Click the Search Results icon on the Toolbar

· Choose the Results command from the Search menu to redisplay the Search Results 
window. 

This is useful when you have viewed several documents and wish to review the overall 
results of the search, or refine the search in some way.

To go back to the previous location:

· Click the Go Back icon on the Toolbar 

· Choose the Go Back command on the Go to menu
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Improving Your Search Results

As you work with the results of your search, you may discover that your Search Results List 
is not quite on target for your needs. The Common Ground Search functionality provides a 
number of options for rerunning and refining your search. 

Change the document collections -- Instead of searching in all collections, you may wish 
to select particular collections.

Find particular documents -- Besides the option of selecting collections, you also have 
the opportunity to specify particular information about documents of interest. The expanded 
Search Window allows you to specify document information and dates.

Limit the documents -- The expanded Search Window allows you to specify the maximum 
number of documents returned or to eliminate documents with low scores from your Search 
Results List. 

Change the Query -- The Query language contains many constructs that can help you. 

Click here for more information on Query syntax.
Constrain the search -- You can add special information about how to interpret the query 
phrase.
Refine the search -- In cases where you have performed a successful search but obtained 
a Search Results List that is too long to be useful, you can reduce the length of the list by 
refining the search. 

Click here for information on constraining your search with the Search Window.
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Search Window

The Search window allows you to search through chosen DigitalPaper collections for the 
provided text string. When you click the More button in the Search window, the window 
lengthens to display additional search options.

Use the expanded Search window to limit the search to a specific publisher, date range, and 
a specific number of documents. You can set other options (described below) to further 
refine your search.

To display the Search window, use one of the following methods:

· Click the Query icon in the Toolbar

· Choose the Query command form the Search menu

· In the Program Manager/Explorer, double-click the Search icon in the CD’s Program 
Group, then click the Search... button

Search Window Options

Search in -- Specify whether Search should look through all of your collections

Selected 
collections

Limit search to the collections 
checked in the Document 
Collection dialog box.

All collections Search all documents in all 
collections.

Collections button -- Display the Document Collections dialog box.

Search for -- Specify the query, or search terms, as an alphanumeric string.

Search button -- Start the search process.

More button -- Expand the Search window to display additional options to constrain your 
query.

Expanded Search Window Options

To access the expanded Search window, click the More button in the Search window.

Publisher and Organization -- Specify the Publisher or the Organization to limit the search
to only those documents with matching Publisher and Organization names as shown in the 
Document Information dialog box. You can leave these fields blank to search in all 
documents.

The Publisher and Organization information for a document is placed permanently into the 
document when it is created by Maker.

Keywords -- Specify one or more keywords to limit the Search to only those documents that



have matching keywords.

Creation Date: After and Before -- Specify a date in either or both of the fields to limit 
the search to only those documents with creation dates that fall within this date range. 

Dates entered in this field must use the Short-Date format you selected in the International 
settings in the Windows Control Panel. Refer to your Windows User's Guide for more 
information.

Modification Date: After and Before -- Specify a date in either or both of the fields to 
limit the search to only those documents whose last modification date falls within this range 
of dates.

Maximum number of documents -- Limit the number of documents displayed in the 
Search Results window to the integer that you specify.

Minimum acceptable score -- Limit the search to documents with scores equal to or 
higher than the number you specify.

Word Match -- Specify how you want the query interpreted: 

· Exact -- Interpret the query literally: the words in the document must exactly match 
the words in the query. 

· Stem (Default) -- Retrieve documents that include one or more variants of the search
term. For example, if the search term is "assert," Search retrieves documents that 
contain assertion, asserts, asserting, asserted, and so on.

· Thesaurus -- Use the Search Thesaurus to retrieve documents that contain one or 
more synonyms of the specified search terms.

Match Case -- Use upper and lowercase characters in the query literally. All characters must
appear in a document exactly as you specified them in the Search for field.

Use Proximity -- Enables the use of proximity when perfroming a search. "Proximity" 
defines how many words separate the words specified in a search term. The closer the terms
are, the higher the document will score. For example, if your search term was "large cat" 
then the document that contains "a large and hairy siamese cat" will contain a hit.

This option works only if you check this box and specify several search terms in your query 
using commas.

Refine -- On the next search, use the previous Search Results List as the new "search in" list
and apply the constraints you entered in the expanded Search window. 

This checkbox is disabled until you have run at least one search and obtained a results list. 

Less Button -- Display only the standard Search window fields. This button returns the 
Search window to its default size.
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Search Results Window

Search displays results of a search process in the Search Results window. This window lists 
the documents that contain the search terms. Next to each document name is an icon. If the
icon contains a plus (+), the document contains a Table of Contents to help you locate the 
search hits in that document. Initially, the highest scoring document is displayed at the top 
of the list.

Window Fields

Score -- Each document is given a score. The highest score is 100, indicating that the 
document is considered a "perfect match" for the search criteria; the lowest possible score is
0, indicating that no match was found in the document. Documents with scores of 0 are 
irrelevant for your search and do not appear in the Search Results List.

Table of Contents Icon -- The document icon  identifies a document that has a Table of 
Contents. Double-click the icon to display the Table of Contents. The icon symbol changes 
from a plus (+) to a minus (-). You can click an entry to highlight it, and then click the Open 
button to View that document starting at the point you selected in its Table of Contents.
The document icon  indicates that the Table of Contents is currently displayed. Double-click
the icon to remove the Table of Contents display.
Show Context -- Check to display the context of each hit. A list of matches appears below 
the document name. Highlight a match, then click the Open button to open the document in 
the ProViewer and display the selected hit in the Document Window.

Open and View a Document -- View the selected document. Select the document by 
highlighting its name, one of its hits, or one of its Table of Contents entries and click the 
Open button. The ProViewer displays the selected document with the first (or selected) hit or
Table of Contents entry visible in the Document Window.

Sort -- Display the Sort Results window, allowing you to change any of the order in which 
hits are listed in the Search Results window. 

New Search -- Redisplay the Search window, allowing you to change any of the search 
parameters and run another search. 
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Getting Technical Support

You can contact our Technical Support Department, Monday to Friday, between 9:00 a.m. 
and 7:00 p.m. Eastern Standard Time at:

Hummingbird Communications Ltd.
1 Sparks Avenue, North York, Ontario, Canada M2H 2W1

Telephone: (1) 416-496-2200
Fax: (1) 416-496-2207
BBS: (1) 416-496-9233

e-mail: support@hummingbird.com
FTP: ftp.hummingbird.com

WWW: http://www.hummingbird.com

When calling Hummingbird’s Technical Support line, please be at the computer so the 
Technical Support Representative can provide guidance through the steps needed to be 
taken. Also, please be prepared to provide the information listed below. 

· Product Name & Version Number

· Operating System & Version Number

· Type of computer (make/model)

· Processor (Pentium/speed)

· Memory (amount/capacity)

· Memory Managers (if applicable)

· Hard Disk Space (capacity)

· Video Card (make/model/memory)

· Transport Software & Version Number

· Network Card & Settings (driver type/make/model/8 vs 16 bit)

· Server/Host System Type (UNIX/VAX/VMS/PC/NT, and so on)

· Is the problem repeatable? 

· What are the steps to reproduce the problem?

· What was being done when the problem occurred?

 



Search Facility Menu Commands and Tools
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Query Command (Search Menu)

Searches in defined document collections for documents with specific content; allows you    
to create and edit document collections.    This is the principal access to the Common Ground
Search facility. You can also access the Common Ground Search facility from an icon in the 
Common Ground Program Group.
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Results Command (Search Menu)

Displays the Search Results List generated by the Query command. This command is 
inactive when no search has been performed.
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Next Document Command (Search Menu)

Opens the next document in the Search Results List, replacing the current document in the 
Document Pane. This command is inactive when there is no next document or when no 
search has been performed.
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Previous Document Command (Search Menu)

Opens the previous document in the Search Results List, replacing the current document in 
the Document Pane. This command is inactive when there is no previous document or when 
no search has been performed.
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Next Hit Command (Search Menu)

Displays the appropriate portion of the current document that contains the next instance of 
the search term found by a Query command. This command is inactive when:

· No search has been performed

· No terms have been found

· There are no more hits in the current document
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Previous Hit Command (Search Menu)

Displays the appropriate portion of the current document containing the previous instance of
the search term found by a Query command. This command is inactive when:

· No search has been performed

· No terms have been found

· There are no earlier hits in the current document
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ProViewer Toolbar with the Search Facility

The search tools in Toolbar are inactive unless you have a version of ProViewer that contains 
the Search Facility. The search tools are located to the right of the Go Back tool (see the 
illustration above).    Selecting a search icon on the Toolbar produces the same result as 
choosing the equivalent command from the menu. 
Hiding the Toolbar -- Select the Toolbar command from the Window menu. 

Redisplaying the Toolbar -- Select the Toolbar command from the Window menu.
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 Using the Query Tool

Use the Query tool to access the Search Facility. To use the Query tool, click on the button to 
display the Common Ground Search window.
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 Using the Results Tool

Use the Results tool to display the results of the last query. This tool is inactive when no 
search has been performed. 

To use the Results tool, click on the icon to display the Common Ground Search Results 
window.
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 Using the Next Hit Tool

Use the Next Hit tool to display the next instance of the search term found by a Query 
command. This tool is inactive when you have not performed a search or if there are no 
additional instances of the search term.

To use the Next Hit tool, click on the Next Hit icon to display the next matching term.
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 Using the Previous Hit Tool

Use the Previous Hit tool to redisplay the previous instance of the search term found by a 
Query command. This tool is inactive when you have not performed a search or if there are 
no previous instances of the search term.

To use the Previous Hit tool, click on the Previous Hit icon to go back to the previous 
matching item

Using the Search Facility

Specifying a Query

Query command

Next Hit Too  l  

Previous Hit command



Using the Next Document Tool

Use this tool to open the next document in the Search Results List. This tool is inactive if you
have not performed a search or if the current document it the last document on the Search 
Results List.

To use the Next Document tool, click on the Next Document icon to replace the current 
document with the next document in the Search Results List.
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 Using the Previous Document Tool

Use this tool to open the previous document in the Search Results List. This tool is inactive if 
you have not performed a search or if the current document it the first document on the 
Search Results List.

To use the Previous Document tool, click on the Previous Document icon to replace the 
current document with the previous document in the Search Results List.
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Save Tool
Saves the document. Works the same as the Save command on the File menu.



Print Tool
Prints the document. Works the same as the Print command on the File menu.



Open Tool
Displays the Open dialog box so you can specify which document to open. Works 
the same as the Open command on the File menu,



Pointer Tool

Restores cursor to normal arrow shape. Use it to select commands or select items to 
display for editing.



Table of Contents Tool
Changes the cursor to look like the icon. Use it to create Table of Contents entries.



Find Tool
Displays the Find dialog box so you can specify text for which to search. Works 
the same as the Find command on the Search menu.



Go Back Tool

Returns to the last navigation that you performed.



Grabber Tool

Changes the cursor to look like the Grabber icon. Use it to move the document or page.



I-Beam Tool
Changes the cursor to an I-Beam. Use this tool to select text in the document.



Hyperlink Tool
Changes the cursor to look like the    Hyperlink icon with an I-Beam or Marquee. 
Use this tool to select the source of a link.



Highlighter Tool
Changes the cursor to look like the Highlighter icon with an I-Beam or Marquee. 
Use this tool to create a highlighted area in the document.



Note Tool
Changes the cursor to look like the Notes icon. Use this tool to place a note on the
document.



Marquee Tool
Changes the cursor to a crosshair shape. Use this tool to select or define a 
rectangular area of the document page.



Zoom In Tool
Changes the cursor to a magnifying glass with a plus (+) in the center, Use this 
tool to magnify the current page.



Zoom Out Tool
Changes the cursor to a magnifying glass with a minus (-) in the center, Use this 
tool to decrease the magnification of the current page,



Bookmark Tool
Changes the cursor to look like the Bookmark icon. Use this tool to mark a specific
location in the document to which you want to navigate.



Query Tool
Opens the Common Ground Search window.



Search Results Tool
Opens the Search Results List dialog box.



Next Document Tool
Opens the next document in the Search Results List, replacing the current 
document in the Document Pane. 



Previous Document Tool
Opens the previous document in the Search Results List, replacing the current 
document in the Document Pane. 



Next Hit Tool
Displays the portion of the document that contains the next instance of the 
search term in the current document.



Previous Hit Tool
Displays the portion of the document that contains the previous instance of the 
search term in the current document.
 



Document Collections Dialog Box

The Document Collections dialog box is the first dialog box to appear when you open the 
Search Facility. You can also access the Document Collection dialog box from the Search 
window, by clicking on the Collections button. 

Dialog Box Options

(Check Column) -- Double-click to check or uncheck collections. A check indicates that the 
document will be included in any search that is limited to selected collections.

You can also toggle the check by highlighting a collection and pressing the space bar once.

Collections -- Displays the collections on your list. Click a collection description to identify 
which collection you want to edit or update. 

Search Button -- Click this button to display the Search Query dialog box.
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